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1 Introduction to AirPort
AirPort is a simple, fast, affordable way to access the Internet from anywhere in your home, 
classroom, or small office without cables, additional phone lines, or complicated networking 
software. AirPort is a wireless local area network (LAN) technology that provides high-
performance wireless communication between multiple computers and the Internet. AirPort 
allows you to share a single Internet connection with more than one computer at the same 
time and share files between computers.

About the AirPort Base Station

The AirPort Base Station establishes a wired connection to the Internet and wireless 
connections to AirPort-equipped computers. A 56K modem is built into the base station for 
dialup (PPP) Internet access. One 10BASE-T Ethernet ( ) connection for cable or DSL 
modem connections, and one10/100Base-T connection (G) for high speed access to your 
LAN are built in. The base station manages communications between the Internet and the 
AirPort-equipped computers.

The AirPort Base Station can connect to the Internet in the following ways:

m Using the internal modem 

m Using 10BaseT Ethernet to connect a cable or DSL modem to the WAN ( ) port

m Using 10/100BaseT Ethernet to connect to an Ethernet LAN (G) with Internet access

Once the base station is connected to the Internet, AirPort-equipped computers can connect 
to the Internet by joining the AirPort network. Computers connected to the network by 
Ethernet can also share the base station’s Internet connection. See Chapter 2, “Setting Up 
Your AirPort Base Station,” for instructions on how to set up the base station for Internet 
access.

Note:  To use AirPort to access the Internet, you must have an account with an Internet 
service provider (ISP). Fees may apply. In addition, you need a traditional way to access the 
Internet, through a phone line, cable or DSL modem, or Ethernet network.
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The AirPort Base Station at a Glance
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About the AirPort Base Station Ports

Security Slot and Keyboard Lock

You can purchase a security cable and lock, such as the Kensington MicroSaver® Security 
Cable to protect your AirPort Base Station. With a lock, you can secure your base station to a 
desk or table. 

W Internal Modem Port

Connect one end of the phone cord to the internal modem 
port and the other end to your telephone jack.

10BaseT Ethernet WAN ( ) Port

Connect the cable or DSL modem to the Ethernet WAN port 
( ) on the AirPort Base Station the same way it was 
connected to your computer.

G 10/100BaseT Ethernet LAN (G) Port

Connect the Ethernet cable to the Ethernet LAN port (G) on 
the AirPort Base Station the same way it was connected to 
your computer.

¯ Power Adapter Port

Plug the AirPort Base Station power adapter into the power 
adapter port and connect it to an electrical outlet.

Sample locking device with security cable
 Introduction to AirPort 7
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About the AirPort Software

The following software for setting up and using your AirPort Base Station in Mac OS X is 
included on the AirPort CD.

The following software for setting up and using your AirPort Base Station in Mac OS 9 is 
included on the AirPort software CD.

AirPort Setup Assistant

Use the AirPort Setup Assistant to configure the AirPort Base Station 
and to set up your computer to use AirPort.

AirPort Admin Utility

The AirPort Admin Utility, located in the Utilities folder inside the 
Applications folder, is an advanced tool used to set up and manage 
the AirPort Base Station. Use the AirPort Admin Utility to adjust 
network, routing, and security settings, and other advanced options. 

AirPort status icon in the menu bar

Use the AirPort status icon to switch quickly between AirPort 
networks, monitor the signal quality of the current network, and 
turn AirPort on and off.

AirPort Setup Assistant

Use the AirPort Setup Assistant to configure the AirPort Base Station 
and to set up your computer to use AirPort.

AirPort

Use the AirPort application, located in the Apple (K) menu, to 
switch between different AirPort networks, set up a Computer-to-
Computer network, connect and disconnect your AirPort Base 
Station from the Internet, and monitor AirPort Base Station modem 
status.

AirPort Admin Utility

The AirPort Admin Utility, located in the AirPort folder inside the 
Apple Extras folder, is an advanced tool used to set up and manage 
the AirPort Base Station. Use the AirPort Admin Utility to adjust 
network, routing, and security settings, and other advanced options. 

AirPort Control Strip module

Use the Control Strip to switch quickly between AirPort networks, 
monitor the signal quality of the current network, and turn AirPort 
on and off.
8 Chapter  1  
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2 Setting Up Your AirPort Base Station

What You Need to Set Up the AirPort Base Station 
for Internet Access

Before you set up the AirPort Base Station for Internet access, make sure of the following:

m You have a computer with an AirPort Card installed.

m The computer is already configured to access the Internet using its built-in modem or 
another method such as a cable modem, DSL modem, or Ethernet network. (As part of 
the setup process, a copy of your computer’s active Internet settings will be transferred to 
the AirPort Base Station.)

m You have an account with an Internet service provider (fees may apply) or you have 
Internet access through a network. 

For more information on using AirPort with your Internet account, contact your ISP or go 
to the AppleCare Knowledge Base at kbase.info.apple.com

If you do not have an AirPort-equipped computer, see the document called “Installation 
Instructions” on your AirPort software CD for information on other ways to set up your 
AirPort Base Station.
 9
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Before You Begin
m Choose a suitable location for your AirPort Base Station.

You can place your AirPort Base Station on a desk, bookcase, or other flat surface, or you 
can mount it on a wall. Place your AirPort Base Station in the center of your home or 
office, in a location that is away from any potential source of interference, such as a 
microwave oven or large metal appliances, and is close to power and phone outlets (or a 
network connection). 

For more information on mounting the AirPort Base Station, see “Mounting the AirPort 
Base Station on a Wall” on page 13

m Make sure your computer has the latest version of the AirPort software installed. For the 
latest information on the AirPort software, check the following Apple Web sites:

m The Apple AirPort Web site at www.apple.com/airport

m The Apple Support Web site at www.apple.com/support

Setup Overview

Once you’re ready, you can set up the AirPort Base Station in three easy steps:

1 Test your Internet connection using your computer.

2 Plug in the AirPort Base Station.

3 Use the AirPort Setup Assistant.

Step 1: Test Your Internet Connection Using Your Computer

m Test your Internet connection and the Internet settings on your computer by connecting 
to the Internet using your computer’s internal modem or other method.

As part of the setup process, the AirPort Setup Assistant transfers a copy of your computer’s 
active Internet settings to the AirPort Base Station, so these settings must be accurate.
10 Chapter  2  
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Step 2: Plug in the AirPort Base Station

1 Plug the AirPort Base Station power adapter into the power adapter port and connect it to an 
electrical outlet. 

The AirPort Base Station automatically turns on when the power adapter is plugged in and 
connected to an electrical outlet. There is no power switch. 

When you first plug in the base station, the status lights glow green. These lights indicate that 
the base station is starting up. When the middle light glows green, startup is complete. The 
startup process takes about 30 seconds. See  “Monitoring AirPort Base Station 
Communication” on page 16 for a complete explanation of the lights on the AirPort Base 
Station and what they indicate.

2 Connect the AirPort Base Station to your phone line, DSL or cable modem, or network.

m If you use a standard modem and analog telephone line (the type of telephone line found 
in most residences) to access the Internet, connect one end of the phone cord to the 
internal modem port (W)and the other end to your telephone jack.

m If you have an Internet account that uses a device such as a DSL or cable modem, connect 
the device to the Ethernet WAN port ( ) on the AirPort Base Station the same way it 
was connected to your computer.

m If you use an Ethernet LAN for Internet access, connect the Ethernet cable to the 
Ethernet LAN port (G) on the AirPort Base Station the same way it was connected to 
your computer.

Note:  All of the wired traffic on the AirPort network travels through the LAN port only, 
unless you are connected to the Internet via the internal modem, then both Ethernet ports 
( WAN  and LAN G) carry wired traffic.

Important  Use only the power adapter that came with your AirPort Base Station. Adapters for 
other electronic devices may look similar, but they may damage the base station.

Internal
modem port

Power
adapter port

Security
slot

Ethernet
(LAN) port

Ethernet
(WAN) port
 Setting Up Your AirPort Base Station 11
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Step 3: Use the AirPort Setup Assistant

Use the AirPort Setup Assistant to configure the AirPort Base Station.

The AirPort Setup Assistant

m sets up your AirPort network

m transfers the active Internet settings from your computer to the AirPort Base Station

m configures your computer to access the AirPort network created by the AirPort 
Base Station

In Mac OS X, the Setup Assistant is located in the Utilities folder in the Applications folder on 
your hard disk. In Mac OS 9, the Setup Assistant is located in the AirPort folder, in the Apple 
Extras folder in the Applications folder on your hard disk.

m Open the AirPort Setup Assistant and follow the instructions on screen.

Note:  Do not open the AirPort Setup Assistant until you have plugged in the base station 
and the middle light glows green.

This AirPort Setup 
Assistant screen appears if 
a new AirPort Base Station 
is detected and the 
computer has never been 
set up to use AirPort. 

A different screen appears 
if there are other networks 
in range or the computer 
has already been set up 
to use AirPort.
12 Chapter  2  



                

LL1017.Book  Page 13  Wednesday, September 19, 2001  1:11 PM
If you are setting up your base station for the first time and you do not see an option to set 
up a base station:

1 Quit the AirPort Setup Assistant by choosing Quit from the File menu. 

2 Make sure that you have plugged in your base station and that the middle light glows green. 

3 Open the AirPort Setup Assistant again and follow the instructions to set up your computer 
and the AirPort Base Station.

At the end of the setup assistant, you can connect to the Internet.

Mounting the AirPort Base Station on a Wall

You can use the mounting bracket provided with your AirPort Base Station to mount it on a 
wall. Follow these steps:

1 Select a location close to power and phone outlets (or a network connection).

2 Screw the mounting bracket into a wall stud using the two screws that came with the 
base station.

Mounting bracket
 Setting Up Your AirPort Base Station 13
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3 Locate the three mounting bracket holes on the bottom of the base station.

4 Feed the cables through the mounting bracket and then connect them to the base station.

The unit is designed to mount with the ports on the top (Apple logo right-side up), with the 
cables passing behind the unit through the mounting bracket as shown.

Note:  The mounting bracket has enough space for four cables (power, phone, and two 
Ethernet cables), as shown in the illustration. In most cases only two cables are used.

5 Carefully attach the AirPort Base Station to the mounting bracket by inserting the two prongs 
on the mounting bracket into the mounting bracket holes, and clipping the third prong on 
mounting bracket around the bottom lip of the base station.

Mounting bracket holes
14 Chapter  2  
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3 Using Your AirPort Base Station
Use the information provided in this chapter to

m monitor your AirPort Base Station status

m connect to and disconnect from the Internet

m add computers to your AirPort network

m use the AirPort Admin Utility to modify advanced base station settings

Monitoring the AirPort Base Station’s 
Internet Connection Status
m In Mac OS X, use the Internet Connect application to monitor the status of your AirPort 

Base Station’s Internet connection, as shown below.

m In Mac OS 9, use the AirPort application to monitor your connection.
 15



LL1017.Book  Page 16  Wednesday, September 19, 2001  1:11 PM
Monitoring AirPort Base Station Communication

The following table explains the lights on the AirPort Base Station and what they indicate.

Note:  The AirPort Base Station does not have an internal speaker, so you do not hear the 
modem dial when the base station is connecting to the Internet.

Connecting to the Internet 

If you use a dialup ISP, the AirPort Base Station establishes an Internet connection 
automatically when any computer on the AirPort network opens an application that requires 
an Internet connection. If you are connected to an AirPort network that has continuous 
Internet access via Ethernet, DSL, or a cable modem, you can connect to the Internet by 
opening and using any application that requires an Internet connection.

1       2       3

Light number Indicator Status

1 Flashing green The AirPort Base Station is communicating via 
AirPort.

2 Steady green The AirPort Base Station is receiving power 
and in normal operating mode.

3 Flashing green The AirPort Base Station is communicating via 
the Ethernet or modem port.

Flashing green The internal modem is dialing your ISP.
16 Chapter  3  
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Connecting to the Internet Manually

If you don’t want the AirPort Base Station to connect automatically, open the AirPort Admin 
Utility, select your base station, and click Configure. Then click the checkbox in the Internet 
panel to deselect “Automatically dial.”

When you want to connect to the Internet

m In Mac OS X, open the Internet Connect application, located in the applications folder on 
your hard disk.

m Choose AirPort from the Configuration pop-up menu, and click Connect.

m In Mac OS 9, open the AirPort application, located in the AirPort folder in the Apple Extras 
folder in Application (Mac OS 9) on your hard disk.

m Click Connect.

Disconnecting From the Internet

The AirPort Base Station automatically disconnects from the Internet after a period of 
inactivity. 

If you are using a dialup ISP, you can manually disconnect from the Internet using the 
Internet Connect application in Mac OS X, or the AirPort application in Mac OS 9. 

m Open the application and click the Disconnect button.

Connecting Additional Computers to Your AirPort Network

Once you’ve set up the AirPort Base Station, you can configure any AirPort-equipped 
computer to access the wireless network you just created.

m Open the AirPort Setup Assistant on the computer you want to use and select the “Set up 
your computer to join an existing wireless network” option.

Configuring the AirPort Base Station With the 
AirPort Admin Utility

The AirPort Setup Assistant provides complete configuration options for most AirPort 
networks. For advanced settings, you can use the AirPort Admin Utility (located in the 
Utilities folder in the Applications folder in Mac OS X, and in the AirPort folder inside the 
Apple Extras folder in the Applications (Mac OS 9) folder on your hard disk in Mac OS 9) to 
configure your AirPort Base Station. The AirPort Admin Utility allows you to do the following:

m Configure your AirPort network, including changing the network name and the password, 
and indicating whether users need a password to join your network.
 Using Your AirPort Base Station 17



LL1017.Book  Page 18  Wednesday, September 19, 2001  1:11 PM
m Change the AirPort Base Station name and password.

m Enter the TCP/IP settings for your AirPort Base Station.

m Configure ISP information such as telephone number, user name, and password.

m Set up the way Internet access is provided to computers on the AirPort network.

Note:  By default, the AirPort Base Station is set to use the DHCP Internet protocol to 
share a single IP address. The base station provides a private address in the range of 
10.0.1.2 to 10.0.1.200. You can use the AirPort Admin Utility to configure the base station 
to distribute a specified range of IP addresses or turn off Internet Sharing and assign fixed 
IP addresses to all computers on the network instead.

More Information About AirPort

You can find more information about AirPort in the following locations:

m AirPort Help

Look in AirPort Help for information on setting up an AirPort network, using an AirPort 
Base Station, editing base station settings, avoiding sources of interference, locating 
additional information on the Internet, and more. Open Mac Help from the Help menu 
and click the “Go to Help Center” button in Mac OS X, and choose AirPort Help from the 
list. In Mac OS 9, choose Help Center from the Help menu. In the Help Center, click 
AirPort Help.

m Balloon Help

For information on specific items in any of the AirPort applications, open the Help menu 
and choose Show Balloons. Then point to the item that interests you.

m “__________________”

For in-depth information on configuring AirPort networks, open the “_____________” 
document, located on the AirPort CD in Mac OS X, and in the AirPort folder inside the 
Apple Extras folder on your hard disk in Mac OS 9.

m World Wide Web

The Apple AirPort Web site at www.apple.com/airport

The Apple Support Web site at www.apple.com/support

Important  If you use the AirPort Admin Utility instead of the Setup Assistant to configure 
your base station for the first time, you may be asked for a password. The initial password for 
the AirPort Base Station is public. 
18 Chapter  3  
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4 Troubleshooting
The AirPort Setup Assistant says that the proper AirPort hardware was 
not detected.

m Make sure that the computer you are using has an AirPort Card installed. If you recently 
installed the card, shut down your computer and make sure the card is properly installed. 
Make sure that the AirPort antenna is securely connected to the card (you should hear a 
click when the antenna is connected securely). Make sure that the other end of the card is 
firmly inserted into the connector in the AirPort Card slot.

The “Set up an AirPort Base Station” option is not available, or the Setup 
Assistant can’t detect the AirPort network created by the base station.

m Make sure that the AirPort Base Station is plugged into a working electrical outlet.

m Make sure that your computer is in range of the AirPort Base Station, or is connected to 
the Ethernet LAN (G) port by an Ethernet cable. The typical range for AirPort 
communication is 150 feet (45 meters) in any direction.

m Make sure your computer and AirPort Base Station are away from any source of 
interference, such as metal walls or microwave ovens. Reposition your computer and 
check to see if the network becomes available. If that does not work, try repositioning the 
base station. For a complete list of sources of interference, see “_______” on the AirPort 
CD in Mac OS X, and in the AirPort folder inside the AppleExtras folder in the Applications 
(Mac OS 9) folder on your hard disk.

m Restart your computer.
 19
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Your Internet connection has problems.

m Test your Internet connection by connecting to the Internet using your computer’s 
internal modem or another method instead of using the AirPort Base Station.

After you test your Internet connection, make sure to switch your TCP/IP configuration 
back to AirPort. In OS X, choose AirPort in the Show pop-up menu on the Network pane 
of System Preferences. In OS 9, open the TCP/IP control panel, choose Configurations 
from the File menu, and select AirPort.

m Some Internet service providers (ISPs) are not currently compatible with AirPort.

For more information on using the AirPort Base Station with your Internet account, 
contact your ISP or look on the Apple Support Web site at www.apple.com/support

m If there is a microwave oven in the vicinity that is frequently in use, it may cause problems 
with your Internet connection. Use the AirPort Admin Utility to select your base station, 
click Configure, and click the “Interference robustness” checkbox in the AirPort panel.

Your Internet browser can’t load the requested Web page.

m You may have tried to go to a Web page before the AirPort Base Station was finished 
connecting to your ISP. Wait until the AirPort is connected and then go to the Web page 
again. Monitor your connection in Mac OS X with the Internet Connect application. In 
Mac OS 9, use the AirPort application to monitor your connection.

m If you are using a dialup connection, your base station may not be configured to dial 
automatically when you open an application that requires an Internet connection. To 
configure your base station to dial automatically, open the AirPort Admin Utility, select 
your base station, and click Configure. Then click the checkbox in the Internet panel to 
select “Automatically dial.” You can also use the Internet Connect application in Mac OS X, 
or the AirPort application in Mac OS 9 to connect to the Internet, then open your Web 
browser.

You forget your AirPort network or base station password.

You can clear the AirPort network or base station password by resetting the base station. 
Follow these steps:

1 Make sure that TCP/IP on your computer is configured in the following way:

m In Mac OS X, set the Show pop-up menu on the Network pane of System Preferences
to AirPort.

m Set the Configure pop-up menu is to Using DHCP.

m In Mac OS 9, set the “Connect via” pop-up menu of the TCP/IP control panel to AirPort.

m Set the Configure pop-up menu is to Using DHCP Server.
20 Chapter  4  
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2 Insert a straightened paperclip into the reset button. Press and hold the reset button for one 
full second. 

The middle light flashes green, indicating that the base station is in reset mode. The base 
station remains in reset mode for five minutes. If you do not make your changes within five 
minutes of pressing the reset button, you must reset it again.

3 Use the AirPort status icon in the menu bar of Mac OS X, or AirPort Control Strip module in 
Mac OS 9 to select the network created by the base station (the network name does not 
change).

4 Open the AirPort Admin Utility.

5 Select your base station and click Configure.

In the dialog box that appears, change the options you want:

m IP address:  Unless you have been given an IP address by your ISP or system 
administrator, do not change the IP address.

m The AirPort Base Station password 

m Turn encryption on to activate password protection for your AirPort network. 

m If you turn on encryption, enter a new password for your AirPort network.

6 Click OK.

The base station restarts to load the new settings.

Reset button
 Troubleshooting 21
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You move your AirPort Base Station to a location on your network with 
a different subnet and lose communication with the base station.

Because your AirPort Base Station may have an invalid IP address, do the following: 

1 Make sure that your computer is set to access the network from the same location on the 
network where you are going to move the AirPort Base Station and that it is in range of the 
base station.

2 Make sure that the computer is set to use AirPort.

3 Use the AirPort Setup Assistant to reconfigure the base station.

Additional Information

For more information on using or configuring the AirPort Base Station, see AirPort Help in 
the Help Center, available in the Help menu. There you will find information on editing base 
station settings, avoiding sources of wireless interference, locating additional information on 
the Internet, and more.

You can also find more information at the following Apple Web sites:

m The Apple AirPort Web site at www.apple.com/airport

m The Apple Support Web site at www.apple.com/support

For in-depth information configuring AirPort networks, see the “__________________” 
document on the AirPort software CD or in the AirPort folder inside the Apple Extras folder 
on your hard disk in Mac OS 9.

For wireless certification information, see the AirPort Regulatory Certification document that 
came with your AirPort Base Station.

Important  You cannot use the Setup Assistant if you have used the AirPort Admin Utility to 
turn off Internet Sharing for your base station. If Internet Sharing is turned off, you need to 
reset your base station as described in the previous section and enter a new IP address.
22 Chapter  4  
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AirPort Base Station Specifications
AirPort Specifications

m Wireless Data Rate:  Up to 11 megabits per second (Mbps)

m Range:  Up to 50 meters (168 feet) in typical use (varies with building)

m Frequency Band:  2.4 gigahertz (GHz)

m Radio Output Power:  15 dbm (nominal)

m Standards:  Compliant with 802.11 HR Direct Sequence Spread Spectrum (DSSS) 
11 Mbps standard and 802.11 DSSS 1 and 2 Mbps standard

Interfaces

m RJ-11 connector for built-in V.90 56K modem

Note:  Download speeds vary with line conditions and your ISP’s modem capabilities. 
FCC regulations limit ISP transmission speeds to 53 Kbps in the United States. 

m RJ-45 Ethernet connector for built-in 10BASE-T (G)

m RJ-45 Ethernet connector for built-in 10/100BASE-T ( )

m AirPort

Environmental Specifications

m Operating Temperature:  32° to 95° F (0° C to 35° C)

m Storage Temperature:  –13° to 140° F (–25° C to 60° C)

m Relative Humidity (Operational):  20% to 80% relative humidity

m Relative Humidity (Storage):  10% to 90% relative humidity, noncondensing

m Operating Altitude:  0 to 10,000 feet (0 to 3048 m)

m Maximum Storage Altitude:  15,000 feet (4572 m)

Size and Weight

m Diameter:  6.9 inches (175 mm)

m Height:  3.2 inches (80 mm)

m Weight:  1.25 pounds (565 grams) not including the mounting bracket
 23
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Base Station LED Sequences

The following table explains the base station’s light sequences and what they indicate.

Left Center Right Status/Description

Off Off Off The base station is unplugged, or has failed. If the base 
station is plugged in and all lights are off, contact your 
authorized Apple service provider

On Off On The base station is in self-check mode

On On On The base station is starting up, stage 1

Sequenced flashing, left-to-right The base station is starting up, stage 2

Flashing Flashing Flashing The base station has failed power-on-self test. Contact your 
authorized Apple service provider.

Off Flashing 
slowly

Off The base station is in Soft Reset mode

Off Flashing 
quickly

Off The base station is in Forced Reload mode

Off Alternately 
flashing 
slowly and 
quickly

Off The base station is being reset, either updating the 
firmware or base station configuration

Off/
Flashing

On Off/
Flashing

Left and right flashing indicates network activity
24 Appendix   
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Communications Regulation Information

FCC Declaration of Conformity

This device complies with part 15 of the FCC rules. Operation is subject to the following two conditions:  (1) This 
device may not cause harmful interference, and (2) this device must accept any interference received, including 
interference that may cause undesired operation. See instructions if interference to radio or television reception is 
suspected.

Radio and Television Interference

The equipment described in this manual generates, uses, and can radiate radio-frequency energy. If it is not 
installed and used properly—that is, in strict accordance with Apple’s instructions—it may cause interference with 
radio and television reception. 

This equipment has been tested and found to comply with the limits for a Class B digital device in accordance with 
the specifications in Part 15 of FCC rules. These specifications are designed to provide reasonable protection 
against such interference in a residential installation. However, there is no guarantee that interference will not occur 
in a particular installation. 

You can determine whether your computer system is causing interference by turning it off. If the interference stops, 
it was probably caused by the computer or one of the peripheral devices. 

If your computer system does cause interference to radio or television reception, try to correct the interference by 
using one or more of the following measures:

m Turn the television or radio antenna until the interference stops. 

m Move the computer to one side or the other of the television or radio. 

m Move the computer farther away from the television or radio. 

m Plug the computer into an outlet that is on a different circuit from the television or radio. (That is, make certain 
the computer and the television or radio are on circuits controlled by different circuit breakers or fuses.) 

If necessary, consult an Apple-authorized service provider or Apple. See the service and support information that 
came with your Apple product. Or, consult an experienced radio/television technician for additional suggestions. 

Important  Changes or modifications to this product not authorized by Apple Computer, Inc., could void the FCC 
Certification and negate your authority to operate the product.

This product was tested for FCC compliance under conditions that included the use of Apple peripheral devices and 
Apple shielded cables and connectors between system components. It is important that you use Apple peripheral 
devices and shielded cables and connectors between system components to reduce the possibility of causing 
interference to radios, television sets, and other electronic devices. You can obtain Apple peripheral devices and the 
proper shielded cables and connectors through an Apple-authorized dealer. For non-Apple peripheral devices, 
contact the manufacturer or dealer for assistance. 

Responsible party (contact for FCC matters only):  Apple Computer, Inc., Product Compliance, 
1 Infinite Loop M/S 26-A, Cupertino, CA 95014-2084, 408-974-2000.

Exposure to Radio Frequency Energy

The radiated output power of the optional AirPort Card is far below the FCC radio frequency exposure limits. 
Nevertheless, it is advised to use the wireless equipment in such a manner that the potential for human contact 
during normal operation is minimized.

Industry Canada Statement

This Class B device meets all requirements of the Canadian interference-causing equipment regulations. 

Cet appareil numérique de la Class B respecte toutes les exigences du Règlement sur le matériel brouilleur du 
Canada.
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VCCI Class B Statement

Europe — EU Declaration of Conformity

This device complies with the specifications ETS 300 328 and ETS 300 826, following the provisions of the EMC 
Directive 89/336/EEC.

Notify Your Telephone Company

Some telephone companies require that you notify the local business office when you hook up a modem to their 
lines. 

Information You Need in the United States 

The internal modem complies with Part 68 of the FCC rules. On the back of this equipment is a label that contains, 
among other information, the FCC registration number and ringer equivalence number (REN). If requested, provide 
this information to your telephone company. 

m Ringer equivalence number (REN):   0.8 The REN is useful to determine the quantity of devices you may 
connect to your telephone lines and still have all those devices ring when your telephone number is called. In 
most, but not all areas, the sum of the RENs of all devices connected to one line should not exceed five (5.0). To 
be certain of the number of devices you may connect to your line, as determined by the REN, you should contact 
your local telephone company to determine the maximum REN for your calling area. 

m Telephone jack type:  USOC, RJ-11 An FCC-compliant telephone cord and modular plug are provided with this 
equipment. This equipment is designed to be connected to the telephone network or premises wiring using a 
compatible modular jack that complies with Part 68 rules. See the installation instructions for details.

Telephone Line Problems

If your telephone doesn’t work, there may be a problem with your telephone line. Disconnect the modem to see if 
the problem goes away. If it doesn’t, report the problem either to your local telephone company or to your 
company’s telecommunications people. 

If disconnecting the modem eliminates the problem, the modem itself may need service. See the service and 
support information that came with your Apple product for instructions on how to contact Apple or an Apple-
authorized service provider for assistance. 

If you do not disconnect your modem when it is adversely affecting the telephone line, the telephone company has 
the right to disconnect your service temporarily until you correct the problem. The telephone company will notify 
you as soon as possible. Also, you will be informed of your right to file a complaint with the FCC. 

The telephone company may make changes in its facilities, equipment, operations, or procedures that could affect 
the operation of your equipment. If this happens, the telephone company will provide advance notice in order for 
you to make the necessary modifications to maintain uninterrupted service.  

The optional internal modem will not work with party lines, cannot be connected to a coin-operated telephone, and 
may not work with a private branch exchange (PBX). 

Telephone Consumer Protection Act 

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other 
electronic device to send any message via a telephone fax machine unless such message clearly contains in a margin 
at the top or bottom of each transmitted page or on the first page of the transmission, the date and time it was sent 
and an identification of the business or other entity, or individual sending the message and the telephone number 
of the sending machine of such business, entity, or individual.
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Information You Need in Canada 

The Industry Canada (IC) label identifies certified equipment. This certification means that the equipment meets 
certain telecommunications network protective, operational, and safety requirements. The Department does not 
guarantee the equipment will operate to a user’s satisfaction. 

Before installing this equipment, make sure that you are permitted to connect to the facilities of the local 
telecommunications company. Be sure you use an acceptable method of connection to install the equipment. In 
some cases, you may extend the company’s internal wiring for single-line individual service by means of a certified 
telephone extension cord. Be aware, however, that compliance with these conditions may not prevent degradation 
of service in some situations. 

Repairs to certified equipment should be made by an authorized Canadian maintenance facility designated by the 
supplier. Any equipment malfunctions or repairs or alterations that you make to this equipment may cause the 
telecommunications company to request that you disconnect the equipment. 

In Canada, contact Apple at:  7495 Birchmount Road, Markham, Ontario, L3R 5G2, 800-263-3394

Users should ensure for their own protection that the electrical ground connections of the power utility, telephone 
lines, and internal metallic water pipe system, if present, are connected together. This precaution may be 
particularly important in rural areas.

Warning  Users should not attempt to make such connections themselves, but should contact the appropriate 
electric inspection authority or electrician.

m Load number:   0.3 The load number (LN) assigned to each terminal device denotes the percentage of the total 
load to be connected to the telephone loop that is used by the device, to prevent overloading. The termination 
of a loop may consist of any combination of devices, subject only to the requirement that the sum of the load 
numbers of all devices does not exceed 100.

m Telephone jack type:  CA-11

Informations Destinés aux Utilisateurs Canadiens

L’étiquette d’Industrie Canada identifie un matériel homologué. Cette étiquette certifie que le matériel est 
conforme à certaines normes de protection, d’exploitation et de sécurité des réseaux de télécommunications. Le 
Ministère n’assure toutefois pas que le matériel fonctionnera à la satisfaction de l’utilisateur.

Avant d’installer ce matériel, l’utilisateur doit s’assurer qu’il est permis de le raccorder au réseau de l’entreprise 
locale de télécommunication. Le matériel doit également être installé en suivant une méthode acceptée de 
raccordement. Dans certains cas, le cablage appartenant à l’entreprise utilisé pour un service individuel à ligne 
unique peut être prolongé au moyen d’un dispositif homologué de raccordement (cordon prolongateur 
téléphonique). 

L’abonné ne doit pas oublier qu’il est possible que la conformité aux conditions énoncées ci-dessus n’empechent 
pas la dégradation du service dans certaines situations. De fait, les entreprises de télécommunication ne permettent 
pas que l’on raccorde un matériel aux prises d’abonné, sauf dans les cas précis prévus par les tarifs particuliers de 
ces entreprises.

Les réparations de matériel homologué doivent être effectuées par un centre d’entretien canadien autorisé désigné 
par le fournisseur. La compagnie de télécommuncations peut demander à l’utilisateur de débrancher un appareil 
suite à des réparations ou des modifications effectuées par l’utilisateur ou à cause de mauvais fonctionnement.

Veuillez contacter le fournisseur suivant pour des informations supplémentaires :  

Apple Canada, Inc.
7495 Birchmount Road
Markham, Ontario
Canada L3R 5G2
Apple Canada Customer Assistance Line:  800-263-3394
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Pour sa propre protection, I’utilisateur doit s’assurer que tous les fils de mise à la terre du secteur, des lignes 
téléphoniques et les canalisations d’eau métalliques, s’il y en a, soient raccordés ensemble. Cette précaution est 
particulièrement importante dans les régions rurales.

Avertissement  L’utilisateur ne doit pas tenter de faire ces raccordements lui-même; il doit avoir recours à un 
service d’inspection des installations électriques ou à un électricien, selon le cas.

m Numéro de charge : 0.3  L’indice de charge (IC) assigné à chaque dispositif terminal indique, pour éviter toute 
surcharge, le pourcentage de la charge totale qui sera raccordée à un circuit téléphonique bouclé utilisé par ce 
dispositif. La terminaison du circuit bouclé peut être constituée de n’importe quelle combinaison de dispositifs 
pourvu que la somme des indices de charge de l’ensemble des dispositifs ne dépasse pas 100.

m Type de prise téléphonique : CA-11  

Information You Need in the United Kingdom

This terminal equipment is intended for direct connection to the analogue Public Switched Telecommunications 
Network and is approved for use within the United Kingdom with the following features:

m Modem facility

m Autocalling facility

m Autoanswer facility

m DTMF signaling

m Operation in the absence of proceed indication or upon detection of proceed indication

This product is in conformity with relevant regulatory standards following the provisions of European Council 
Directives 73/23/EEC (Low Voltage Directive) and 89/336/EEC amended by 92/31/EEC (EMC Directive).

Information You Need in Germany

Diese Modem-Karte ist als Endeinrichtung vorgesehen und muss an ein TAE mit F-Kodierung angeschlossen 
werden.

Diese Endeinrichtung ist in Konformität gemäss Niederspannungsrichtlinie 73 / 23 / EWG sowie EMC-Richtlinien 
89 / 336 / EWG und 92 / 31 / EWG.

Information You Need in France

Ce matériel est conforme aux normes applicables de sécurité éléctrique d’après la directive 73 / 23 / CEE et aux 
normes applicables de comptabilité éléctromagnétique d’après la directive 89 / 336 / CEE, modifié par la directive 
92 / 31 / CEE.

Information You Need in Australia

All telecommunications devices are required to be labelled as complying to the Australian telecommunications 
standards, ensuring the health and safety of the operator and the integrity of the Australian telecommunications 
network. To provide compliance with the Australian Communications Authority’s technical standards, please ensure 
that the following AT commands are maintained:

m ATB0 (ITU/CCITT operation)

m AT&G0 (no guard tone)

m AT&P1 (33/66 pulse dial make/break ratio)

m ATS0 = 0 or ATS0 = 2 (no answer or answer greater than one ring)

m ATS6 = n (blind dial delay acceptable range of 2–5 seconds)

m ATS11 = 95 (DTMF period between 70–255 ms)
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For calls that are automatically generated, a total of three call attempts are allowed to a telephone number, with a 
minimum period between calls of 2 seconds. If the call does not connect after three attempts, 30 minutes must 
expire before automatic redialing may be initiated. Failure to set the modem (and any associated communications 
software) to the above settings may result in the modem being non-compliant with Australian telecommunications 
standards. Under these circumstances a user could be subject to significant penalties under the 
Telecommunications Act 1997.

Warning  This card must be properly secured in order for you to use it. Telecommunications network voltages 
exist inside the computer and the telecommunications line connection must be removed before opening the 
computer.

Information You Need in New Zealand

This modem is fully approved to operate on the New Zealand telecommunications network under Telepermit 
number PTC 211/99/077. All telecommunications devices are required to hold a Telepermit and be labelled 
accordingly with the approved Telepermit number to comply with the New Zealand telecommunications standards, 
ensuring the health and safety of the operator and the integrity of the New Zealand telecommunications network.

To ensure compliance, all calls that are automatically generated should not make more than 10 call attempts to the 
same number within any 30 minute period with a minimum period between calls of 30 seconds. Failure to adhere to 
these standards may result in the modem being non-compliant with New Zealand Telecom standards. Under these 
circumstances a user could be subject to significant penalties.

Important  The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has 
accepted that the item complies with minimum conditions for connection to its network. It indicates no 
endorsement of the product by Telecom, nor does it provide any sort of warranty. Above all, it provides no 
assurance that any item will work correctly in all respects with another item of Telepermitted equipment of a 
different make or model, nor does it imply that any product is compatible with all of Telecom’s network services.
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